Autodesk Maya 2012 Release Notes

This document describes known limitations, issues and fixes in Autodesk Maya 2012. It is strongly
recommended that you read this document before you install this release. For reference, you should
save this readme to your hard drive or print a copy.
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Additional Resources
For complete instructions about uninstalling and installing Maya 2012, see: www.autodesk.com/maya‐
faq‐2012‐enu.
For complete documentation and learning resources, see: www.autodesk.com/maya‐docs.
For hardware qualifications, see: www.autodesk.com/maya‐hardware.
To report issues with this release, see: www.autodesk.com/maya‐support.
For more resources, see: www.autodesk.com/maya‐learningpath.

What’s New
To learn about new features in Maya 2012, see: www.autodesk.com/maya‐whatsnewdocs.

What’s Fixed?
The following list contains bug numbers and corresponding descriptions for issues fixed in this release.
For your convenience, the list is separated into distinct feature areas.

API
Bug Number

Description

153122
159047
170988
172891
173501

MLibrary::initialize crashes on Windows if default project directory doesn't exist
MPxToolCommand::doFinalize()fails
MFnAttribute::setDisconnectBehaviour(MFnAttribute::kDelete)
MPlug numElements giving different results
Adding attribute to node then deleting node causes crash

1

Bug Number

Description

175899
176383
180033
181665
187354
201702
205188
213373
213497
227153
237690
239509
244289
245410
251626

Crash when script re‐executes cmd from unloaded plug‐in or runTimeCommand
MFnNumericAttribute::create default values issues for double3/float3
getFlagArgument() doesn't work properly with multi‐use flags
Improvement of custom shader in devkit
Index parameter as a reference in some versions of MArgList::get
Input attributes on custom nodes problem
Cannot rewire connections to node to del in an addNodeAboutToDeleteCallback()
cvColorShader crashes Linux, Windows
Compound attribute array problem
MObject::apiType() fails for kData4Double type
loadPlugin command within userSetup.mel crashes Maya
Error when invoking model editor command
Plug‐in using MPxGlBuffer crashing
Cannot construct MRampAttribute when ramp attribute is empty
Crash in Interactive Prompt/Batch mode when calling MProgressWindow

259795
273987
279601

Array version of MArgList::get() has different function params than others
Document MMessage callback function typedefs
Python: MItDependencyGraph::next() doesn't work because it refers NULL object

298231
302127
309496

Declaration of 'className' method in API classes is inconsistent
There appears to be a memory leak in the MDGContext class
Calling MFnNurbsSurface::copy with parent dagPath argument causes crash

314719
315016
316438
324634
327647
334176
336754
339833
341199
348996
352107
355451
356921
361657
364197
366614
368071
369543

readAndWrite does not do what it advertises to do
MFnDependencyNode::hasAttribute() with non‐exist attribute name cause error
API enums passed as reference
loadPlugin behaves differently than documentation say
Crash with MPxSurfaceShape tweaks
MDGModifier doesn’t support setting plug value on single simple attribute
setCursor does not work in Python when using the default
Creating constraint using MDGModifier::createNode crashed Maya
MItDependencyGraph raises exception at end of iteration
MFnDependencyNode::hasAttribute() fails in python
MGlobal::getFunctionSetList() returns wrong types
Docs for MPxConstraint attributes missing/broken
objExporter crashed Maya
Viewing live device data during playback is broken
Import error with MotionBuilder
Transmit an MDoubleArray through attributes between nodes crashes Maya
Crash with PyQt GUI inside QmayaWindowEventFilterObject::eventFilter()
Maya module description file should support environment variables
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Bug Number

Description

369553
369970
370977
371413

No documentation for custom hypergraph icons
No access to MDrawRequest's matrix
MLibrary::initialize has incorrect signature
Failure to read compound attributes

212181 ‐ catchQuiet does not work properly
catchQuiet now suppresses both MEL and Maya errors. Previously, catchQuiet would only suppress
runtime errors and warnings issued by MEL. It has now been fixed to also suppress messages issued by
Maya commands.

Animation
Bug Number

Description

337159
348994
348998
360016
362100
366567
368147
368148
369010
371032
374312
375220
375225
377247
176266
208651
226110
285356
295536
311108
317304
321756
334472
354579
354655
355037
355905

3D motion blur causes crashes with muscles made with the muscle creator
blendShape does not work well with namespaces
skinCluster envelope attribute not working on Linux
Wrong description in helpfile
Hips translation does not work
PChar: Roll bone extraction behaves opposite to what is expected
HIK : ankle compensation AUTO does nothing
Auto mapping does not work with namespace
Painting skin weight for polygon without vertex or face causes crash
Toggle xray joints not syncing between paintWeights and panel
Exporting to HIK format visible in Maya GUI but does not work
Key modes not functioning
Autokey is not functioning on HIK
weightList ‐> weightList connection doesn't respond to changes as expected
Setting quaternion keyframes at 45 degrees in two axes issues
Synchronize quaternion behavior
Audio will not play or scrub backwards in Maya (Linux)
Graph Editor: Key Stats fields doesn't work when Normalize curves is on
Moving keys via MEL not work with normalized curve
Fcurve linear spline interpolation sometimes has round off errors
Set motion trail increment to zero crash
Maya freezes when scrubbing animation (driver issue)
Keys at high frame count may have round off error exporting to MotionBuilder
Linear tangents are not precise with big number
Newly created constraint nodes are incorrectly added to namespace
Expression collapses when dynamic attribute of expression node is used
Namespace added expression cannot open in external text editor (Windows)
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Bug Number

Description

355906
356454
356501
357453
316090
353238
369263
370275

External Expression Editor corrupts expression
Playblast : improve error message when overwrite fails
Point on poly constraint with objects in namespaces
View Normalized crashes Maya when displaying angular animCurves
treeView callbacks not python compatible
Crash when creating animation layer
Crash on Animation Layer smart Bake with addAnimCurveEdited callback
Unable to use command to set keys in animation layers

File I/O
Bug Number

Description

209041
224452
232139
238865
318517
319964
348379
352137
356148
360138
361947
363680
365519
369753
371560
374798
375943
380178
308583
370219

Project problems when transferring
Import no longer use scene's current namespace
Documentation incorrect on workspace ‐dir and interaction with filebrowser
Cannot delete "lightLinker" nodes
Render ‐proj flag overwrites workspace.mel
Maya fails to launch if lastLocalWS is set to a read‐only directory
Namespace list is not cleared by "file ‐f ‐new" after "rename" of itemFilter
File command can't always find files in workspace "scene" location
File ‐edit ‐modified false doesn’t work correctly
Plug‐ins used in a scene are not saved correctly (if save panel layouts is off)
Double without decimal value saved as integer in Maya ASCII format and overflows
Problems with workspace.mel when rendering on a render farm
Crash on file save
File browser (windows style) defaults to saving files as maya ascii
Maya 2011 overwrites the workspace.mel file
Maya interfering with restart
Intelligent error handling when Deleting 'root' namespace
getAttr ‐expandEnvironmentVariables seems to permanently expand the value
exporting as OBJ causes Maya to crash
Export from Maya to Mudbox issues on Linux 64‐bit
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File Referencing
Bug Number

Description

346698
355882
356243

Instances of grandchild reference lost when switched to proxy with shared edits
Shared edits aren't getting applied to a referenced Proxy
Nested proxy references : unloading/reloading in the Reference Ed. crashes Maya

356371
360067
360903
361877
363295
365154
370178

Crash with ref joints and python commands
Namespace Editor does not refresh between scene loads
Editing on objects in referenced custom file is not saved
Import file problems with child reference edits
“lockNode ‐l 1 ;” causing mesh to lose shader assignment
ExportAsReference breaks render layers
Selective preload window is improperly formatted so you can't expand the list

Fluids
Bug Number

Description

304303
316282
352379
361705

Fluid illuminated by multiple lights gets extra intensity for each
Fluid should inherit velocity from collision object
Dispatched batch rendering fluid with retimed nCache produces incorrect result
Child ramp attribute of compound array attribute cannot be shown correctly

Editors
Bug Number

Description

268706
276226
311068
340891
359236
364163
365828
365928
366783
366822

Sluggish actions in Hypershade
Component Editor cannot edit namespace added meshes
Deleting color extra attribute causes crash
Camera Set Relationship Editor does not refresh
Writing the character number inside a string definition causes the rest of the line
to appear as a comment
Maya hang on file save with isolated select and Outliner window
Issues with the new implementation of File Browser
Cannot change multiple values at once in attribute spread sheet
plusMinusAverage can only set 1 decimal for 2D inputs
Dynamic Relationship Editor does not support full paths

368729
369440
371299
372738
375123
376399

Hypershade ‐ Toggle the create bar on / off
File browser only displays predictive folder names for C:/
File Browser: typing in a folder name saves a file rather than navigating
Component Editor ‐ Smooth Skin Zero Weighting update issue
File Browser issues with new folders and date‐sorting
Component Editor: cannot paste value to multiple cells
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Bug Number

Description

378119

Changing enum attribute with multiple objects selected only changes one object

Modeling
Bug Number

Description

339327
370294
374003
229834
275392
284563
296951
299737
313140
318532
346216
352585
359356
360931
361451
361584
366936
371226

Working with construction history off causes history to stack up
Lattice crash (libPolyEngine)
Poly triangulation causes loss of UVs
Poly Combine/Separate don't respect multiple UV sets
Split Polygon Tool cannot split multiple faces from backface
MItMeshFaceVertex method normaId() causes crash in Maya
Split Polygon Tool cannot drag end point together with starting point
Crash in TpolyEditableGeom collapseEdge
Normals not correct with “Smooth Mesh” option
Combine breaks UV linking
Fill Hole crashes
"polyColorPerVertex ‐q" to object with no vertex color crashes Maya
Crash in conform/undo
polyBridge crashes Maya (empty Color Sets)
polyBridge crashes Maya
Repeatable crash during polyCleanup
Mesh Backface Culling crash
Scale manipulator disappears from UV texture editor when zooming out

Nucleus
Bug Number

Description

278846
348226
350296
354931
369646
371073
373920
355179
369039
372156
373036
379348

nCloth mesh slips down with non‐zero rigidity and high inputMeshAttract value
Painting cache weights from RMB menu does not create weight connections
outmesh precedes the inMesh with inputMeshAttract is set
getAttr on cache node connected outCacheData crashes
Instability triggered by self collision failure, e.g. at knees and elbows
Adding a Damp Texture to nCloth does nothing
Disable collision for nCloth problems
nParticles not simulating correctly, not getting license in batch
Per‐particle attributes not flushed after rewind
Select members on nParticles constraint gives incorrect results
Particle exclusion constraint applied to wrong object
Crashes when loading a scene with cached nParticles and multi object instance

6

Installation and Licensing
Bug Number

Description

348715
358270
358922
360388
362335
364219
369426
372479
377945

Uninstall issues
Maya does not start because d3dx9_42.dll was not found
Installer installs unnecessary files and folders
Log files for deployments should all go to a folder on the server
Error message appears on start
Uninstalling Maya 2011 Hotfix fails if it is installed by deployment
Environment setup issues
License Transfer Utility has incorrect shortcut target in Start Menu
Transfer license utility shortcut is broken

Rendering
Bug Number

Description

296952
321216
328935
329153
329154
338715
356800
356688
363303
364497
369851

Opening UV Texture Editor crashes Maya if object doesn't have material
Multiple material overrides in referenced render layer breaks the render
Stereo horizontal interlace mode flips when resizing
stereoViewer refreshes more than it should
Stereo modelPanel and RenderView give different anaglyph images/results
Playblasting images performance issues
Backburner Web Monitor is unable to quit server tasks in process
Color management conversions between color spaces issues
Maya main GUI does not appear
Hypershade Bookmark crash
"spotLight ‐name lightName" does not return light's name

360939
372487
378585
267280
352089
355177
361362
239367
268575
369361
375649
302958
331212
333388

16‐bit half float EXR output of color managed renderings result in unusable file
Batch bake creates clamped color set
Textures with transparency draw incorrectly
Previous hardware displays cannot display correctly multiple UV and textures
Hardware render doesn't recognize extension padding
MGeometryManager gives wrong element count
Crashes during Hardware Render Buffer render
multi texture with different UV sets and alpha are not displayed in viewport
Viewport rendering does not support multiple UV sets
Different CPU counts combined with Tessellation Error has different results
Using the ‐amt flag is not exiting renders
mental ray crash with a CAD file
BSP2 and Instances not rendering
Particular framebuffer names for OpenEXR multipass are not exported correctly
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Bug Number

Description

333626
358514
361720
362476
365451
371499
359270
360447
369255
377014
380529

Nested references problem
misss_physical creating artifacts and no material
Light's Photon Intensity attribute broken
mib_texture_lookup returns wrong color when filter is on with rasterizer
overall_bump input from empty file texture used as normal map crashes Maya
Color management issues
Background gradient edits ignored by Viewport 2.0
Directional light shadows not working with Viewport 2.0
OGS: Viewport 2.0 will not run on Radeon 5870 unless maya.exe is renamed
Performance problems with custom renderer
Performance problem with render target parameter on MShaderInstance

Color management improvements
Maya 2012 includes improvements made to color management accuracy and image format support. See
bugs 356688, 378635, and 360939 in the What's Fixed list above for more information.

Scripting
Bug Number

Description

212181
219424
266995
267915
269148
295972
309041
310567
317083
318920
319438
323126
329204
331947
334611
348048
349500
357506
363254
366922

catchQuiet does not work properly
Print 1e256 causes a crash
Python commands attached to menuItems produce error after restarting
maya.cmds.shadingNode returns None in batch mode
mayapy.exe: first object creation command doesn't echo the value.
Python created scriptJobs are not listed on "listJobs"
maya.cmds.menu( postMenuCommand=somethingCallable ) leaks memory
Python shelfButton command cannot create MEL sourceType
Memory Leaks in maya.cmds
Python: scriptJob fails to handle "quitApplication" event
Maya Python memory leak with strings
gradientControlNoAttr doesn't list all the flags
substituteAllString can cause infinite loop
MFnUInt64ArrayData.create returns kIntArrayData obj, not kUInt64Array
catchQuiet doesn't work on referenceQuery errors
Keyframe ‐q incorrect if attribute is locked
textField* commands ‐editable false and ‐enable false inconsistent behavior
editAttrLimits.mel with wrong code
Prompt mode fails to connect to sockets
objectTypeUI "viewPanes"; failure
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Plug‐ins
Bug Number

Description

369536
371530

Cannot load 'Substance.so' plug‐in
Substance plug‐in fails to load

General UI
Bug Number

Description

177417
192779
199419
214835
269968
278144
297039
315338
316336
321157
322990
323966
327349
356048
356303
356641
357484
361689
363797
364226
366337

shelfButton ‐dragCallback and ‐dropCallback do not work
setFocus not working properly from command line with quad‐split model view
Closing a torn off menu crashes
Hotbox grabs Xserver
Create a locator, keep selected and open the Channel Control crash (Mac)
Wacom pen interferes with Hotbox
Display iconTextButton on FormLayout (Mac)
Hangs while switching panel views and clicking during redraw
Limiting the redraw to single pass for each refresh
Maximize window not working properly
Maya child windows are not 'raised' when told to
frameLayout's size does not follow its parent's size
optionMenu doesn't appear when initial window size is small on 64‐bit Windows
Tablet pressure breaks undo
Add the abolition of labelAlign option of frameLayout in the online document
Unresponsive marking menu's when right clicking using Wacom pen
Tweak Mode only modifies in a certain axis
Font installing problems
objectTypeUI does not work anymore with menuItem instances
Crash: iconTextButton/iconTextCheckBox/iconTextRadioButton delete from
callback
Using dual screen Hotbox works on primary but not secondary monitor

368109
369075
369758
370084
370342

Hotkeys are not assigning correctly or saving
Hotbox can't move torn off menus
Hotbox display issues (Linux)
Drag and drop to previous version problem
libQtCore crash when navigating through static to dynamic attribute connection

371803
374318
374399
377428

Minimizing Render View Window does not hide contents
Pressing space bar in viewport shifts entire session
Sticky mouse focus (Mac)
Hotbox appears under active window when set to always on top

228719

Cut faces icon dithered
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Bug Number

Description

243470
271454
286095
337641
342512
349279
352293
352756
353503
353746
354067
356147
356239
356902
359057
359266
360622
360911
361915
361956
362290
362566
363499
363909
364036
364377
364524
367064
369415
370285
371129
371964
373806
374513
375741
377467
222149

User Color changes not persisting
The editable flag of the checkBox command does not work
Display Layer's "Make New Layer's Current' and templating error
Double‐click to select edge loop inconsistencies
Random crashing whilst clicking
Trial version label error
Shelf icons not loading on startup
Closing Render View doesn't restore focus to model view
Shelf Icon format preference does not save
Image command no longer reads IFF
Hypershade won't display materials
Refresh error
Render layer override orange text going grey when not in the Attribute Editor
Help > Direct Connect Help fails
getModifiers command returns incorrect values (Mac)
Maya does not save preferences for View Cube Compass
Change Maya foreground color (Linux)
Empty tab with tabLayout
Shelf icons resize to full size upon exiting and re‐opening Maya
Custom shelf buttons disappear upon start
Preferences corrupted when ViewAxis HUD (HUDViewAxis) is removed
Default Hotkeys reset themselves upon re‐opening Maya
Display layer move selection up and down does not work
My custom shelf contains no buttons, new buttons cannot be made
formLayout ‐attachForm doesn't work with iconTextButton and iconTextCheckBox
Shortcut key defaults keep over riding user changes
Renaming an item in the Shelf Editor selects the item at the top of the list
UV Texture Editor snap and grid display incorrect while using "Use Image Ratio"
Deferred dialog problem
File dialog renames incorrect file/folder
Shaders with connected transparency don't display
Mouse input freezes after Hotbox or menu interaction
Row not found error
Extension no longer determines file type
Creating lights doesn't return the name of the new light node
Cannot rename button pop‐up menu
Maya launches a file called "C:/Program" if it exists (Windows)
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358426 ‐ Some controls named with "#" retain it in their object names
In previous versions of Maya, controls named using the "#" sign would retain the sign in their default
labels/titles. For example, creating a button called "myButton#" with no label would create a button
with an object name like myButton1 but the default label on the physical button was "myButton#".
Likewise, creating a window called "myWindow#" with no title would create a window with an object
name like myWindow1, but the default title in the window's title bar was "myWindow#".
With this fix, this no longer occurs. myButton1 will have a default label of "myButton1" and myWindow1
will have a default title of "myWindow1".
369974 ‐ Namespace UI modifications: "Create Reference" window
Previously, the “Name clash” settings in the File > Create Reference and File > Import options were
slightly different. These are now consistent.

Miscellaneous
Bug Number

Description

362548
324638
231287
347811
349382
366589
372735
353517
339703
360131
276518
342917
357550
362006
371656
353624
354604
354734
355142
355972
356304
356993
357382
357546

Organize files in Bonus tools
Cloth scripts missing and/or location changed ‐ cleanup classic cloth references
Large number of connections between two nodes slows down Maya
Document DIRTY PROP, CLEAN PROP & DIRTY BLOCK
Slow node selection with animation layers
Standard particle caching and opacity problems
BMP image causes crash if it is used for iconTextButton
Segmentation fault on startup
HUD frame rate displays partially off screen
Edit and Delete buttons in Hotkey Editor show inactive states (Mac)
Symbolic linked directory path is converted to real path unexpectedly
Active Directory Accounts do not work (Mac)
Script Editor window is rendered unreadable on gesturing right
Tool tips not working in Hypergraph heat map display
Windows don't minimize, they disappear
atan2 documentation incorrect
splash.dll file missing
splash.dll problem
Unused script nodes and performance
Opening Visor crash
Application file has stopped working
menuItems created in Python do not respect arguments passed to them
AutoSave with prompts
More than one voice (language) talking at same time in learning movies
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Bug Number

Description

358004
361646
361777
362024
368804
370122
352811

Load the Maya Muscle plug‐in first
Wacom support problems
shelfLayout does not resize vertically when used in a formLayout
The script editor does not open
TGA support with the image() command
Eyedropper color sampling freezes application
Playblast does not record certain frames

Feature Limitations and Notes
The following section describes limitations and other notes about this release. For your convenience, the
list is separated into distinct feature areas.

Maya Simplified Chinese and Maya Japanese
Bug Number

Description

385734
385735
385736
385737
385886
386027
386029

CHS: The job's name is unreadable in Backburner
CHS: Localized path of destination field is displayed incorrectly in Composite
CHS: The localized path in Exporting and Importing displays incorrectly
CHS: About window displays text incorrectly
CHS: Composite cannot launch when user has limited rights on machine
CHS: The word "server" appears in English in Backburner's Manager
CHS: The word "manager" in warning message appears in English

API and Scripting
Bug Number

Description

279601

Python: MItDependencyGraph::next() doesn't work because it refers NULL object

315016

MFnDependencyNode::hasAttribute() with non‐existent attribute name causes
error

348996

MFnDependencyNode::hasAttribute() fails in Python

349036

Infinite recursion if maya.utils not found

368766

MFnLightDataAttribute::setObject() does not work

Animation
Bug Number

Description

366275

HIK: Channel Box or Attribute Editor values ignored by effectors (sync issue)

357076

Sequencer: File path still points to old location when relocating media files

359322

Get rid of Sequencer node ‐ merge with SequenceManager

379846

Reading a 2011 file adds an additional bone between legs
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Bug Number

Description

381291

HIK : Pull doesn't work in context of retargetting

381927

Can't edit motion trail tangents with Soft Selection

381954

Selecting tool clears selection in the Graph Editor

382154

HIK: Shift+LMB does not allow for selection of keys on timeline if HIK in scene

Dynamics
Bug Number

Description

361522

Problem with too many wrinkles

361361

Bend restitution has no effect when using simple bend solver

365231

Fluid and nCache both delete when deleting fluid cache

358255

Nucleus lockup during interaction (Mac)

327800

vertexColor texture fails when no color set on first frame

356574

Ramp widget handles 50 entries, but ramp attribute can have more

372111

Editing nucleus transform at start frame requires rewind

372115

Problem with solving nParticles in a moving local frame

374787

Assign solver fails when all nucleus Attribute Editor display transforms are on

375400

Particle Instancer rotation not caching with Aim direction set to force

376912

Use Polygon Shells ‐ On/Off at start frame requires another rewind

376927

nParticles project file crashes Maya

377823

getCacheable channels still cache grids that were turned off

380245

Trying to shatter a firework hangs Maya (NURBs shatter can be VERY slow)

380797

Cache resolution mismatch

380888

Cache confusion with two or more fluid shape nodes with the same name

381961

Duplicating PhysX geometry causes Maya to freeze

Modeling
Bug Number

Description

333874

Selection Constraint Angle does not work

Interoperability
Bug Number

Description

382399

Default displacement scale one‐click needs adjustment

380838

ICEFlow ‐ Static deformations don't update in Maya

381203

MotionBuilder to Maya (when closed) doesn’t load the file until the File menu is
clicked
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Rendering and Render targets
Bug Number

Description

360939

16‐bit half float EXR output of color managed renderings result in unusable file

355710

Remove time contrast settings from mental ray globals

378635

Inconsistent color output when rendering EXR and TIFF with mental ray Depth Pass

380204

Cancel Batch Render does not (Linux)

380322

Scenes with dense final gather settings may have longer render times

382158

Warnings occuring in mental ray standalone

372275

Hide mental ray attributes in the Attribute Editor when plug‐in isn't loaded

368762

Separate mental ray plug‐in from Maya

380236

The SatinedMetal preset for the mia_material may have a slightly different
rendered result

380520

Batch render target rendering not supported for more than one renderable
camera

380993

Batch render unable to render rendertargets in SGI, PSD and ALS

380537

Aborting a render target render incorrectly displays render target name in Render
View

379526

Render target recursively filter renders

382287

layeredTexture node clamping float values

381206

Render Target Aspect ratio issue

380660

RenderTarget : Aspect Ratio incorrect with orthographic cameras

379010

Incidence render pass fails to be read from EXR render to Render Target

379007

Material Incidence pass fails to read in Render Target at 16‐bit integer (defaults)

381082

RenderTarget : horizontal shift when used with Stereo Camera

General UI
Bug Number

Description

357561

Minimized windows don't appear in dock and don't stay minimized (Mac)

376551

Render View appears blank with error message

377392

Hypershade loses visual connection with projected textures

381128

Attribute Editor slow to update when selecting camera in scene with CgFX

323322

Color scheme makes UV Texture Editor resizing option obscured (Mac)

350866

Hypershade is slow to open (Mac)

353866

Files greyed out in File browser (Mac)

356339

File browser doesn't update if the window is open

359228

Opening windows (like Attribute Editor) does not bring them to the top if already
open
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Bug Number

Description

369409

connectControl performance issue

380317

Tear off the Recent Commands menu from the Hotbox will not update

356182

Dockable Attribute Editor not refreshing after resourcing AEnodeTemplate

358130

Unattached picture object in formLayout doesn't show up

376333

Scene with multi‐byte name can't be transferred to Mudbox in JP version

376955

Impossible to pick Color with pen tablet (Mac)

377236

Outliner auto‐scroll bug

378069

Errors showing Attribute Editor with some custom attributes

379019

Render View sometimes empty during render (Mac)

356688

Color management conversions between color spaces are inaccurate and unable
to round trip

355340

Hotbox shifted by height/width of border panels when using overlays (Linux)

Miscellaneous
Bug Number

Description

355821

artUserPaintCtx : if Undo is off, Maya crashes after Flood is used

371917

Must use “.” for numbers with LANG environment variable set

378047

Close batch render option box before changing renderers

380473

No manipulator handles in perspective view, but available in all other views

382222

Fur Paint Export Map fails

382310

Remove the ‐exportAsSegment flag of file command and associated methods

370985

Difficulties publishing blend shape sliders due to default published name

356665

No preferences to set Attribute Editor opening behavior

362615

Must set International > Formats > Region to see installer in Japanese (Mac)

381032

CIP: Maya sometimes won't start in Japanese mode (Mac)

Maya Simplified Chinese and Maya Japanese
386052/385230 – launch error when localized documentation is in customized location
If you have installed the Maya 2012 documentation, in any language, to a local drive on your machine,
you must install any subsequent language‐specific documentation to a parallel location in order for the
Help Preferences to function correctly (on Windows and Linux).
For example, if the English documentation is installed at: C:\Program
Files\Autodesk\Maya2012\docs\en‐US, then the equivalent Japanese or Simplified Chinese
documentation must be installed at: C:\Program Files\Autodesk\Maya2012\docs\ja‐JP (or zh‐CN).
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API/Scripting
214262 ‐ MRampAttribute::Interpolation should match internal representation
Previously, the values of the MRampAttribute::MInterpolation enumeration did not match the
corresponding values placed into the the ramp's interpolation attribute. While the MRampAttribute
class itself took care to perform the correct translation whenever setting or retrieving interpolation
values, problems could arise if users tried to set or or retrieve interpolation values directly, using plugs,
data handles or MEL commands. To resolve this inconsistency the MRampAttribute::MInterpolation
enumeration has been adjusted to match the actual values set in the attribute.
For the most part existing code should continue to work without any changes, particularly if it only
accessed interpolation values through the MRampAttribute class. However, if you have code which was
explicitly working around the old problem by translating MInterpolation values to/from the raw
attribute values, then you may need to remove or modify that translation code.
362497 ‐ MFnMesh::setFaceVertexColors doesn't work with locked dcol attribute
Previously the MFnMesh functions which set colors (e.g. setVertexColor) would automatically turn on
color display on the mesh node. This has been changed so that the methods leave the node's color
display option unchanged. If you want to turn it on then you must do so explicitly either by calling the
new setDisplayColors method or by setting the mesh node's 'displayColors' attribute to true.
366299 ‐ Remove overlay drawing methods from M3DView
The overlay drawing methods in M3dView (beginOverlayDrawing, endOverlayDrawing and
clearOverlayPlane) haven't worked properly since hardware overly support was removed in Maya 2011.
Those methods have now been removed from API and the sample plug‐ins which used them have been
updated to use the XOR drawing methods instead (beginXorDrawing, endXorDrawing).
368813 ‐ MFnAttribute::setParent() doesn't add attribute to new parent
The MFnAttribute::setParent() method has been removed. It was exposing an internal Maya function
which, on its own, was not useful and could corrupt a node's attribute hierarchy. To properly set an
attribute's parent, use MFnCompoundAttribute::addChild() to add it to its parent.
368766 ‐ MFnLightDataAttribute::setObject() does not work
Light data attributes, such as those created by MFnLightDataAttribute, were incorrectly reporting their
type as MFn::kCompoundAttribute rather than kLightDataAttribute. This has been fixed. In most cases
the change will be transparent to API users but it is possible that you may have code which is explicitly
checking light data attributes for kCompoundAttribute, in which case you will have to update your code
accordingly.
377401 ‐ namespaceInfo ‐listOnlyDependencyNodes includes internal nodes
namespaceInfo ‐listOnlyDependencyNodes is listing all nodes, including internal nodes and world. This
behavior is not consistent with how we generally return lists like this to the user by default. Instead, by
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default, it should work in a similar manner to the default behavior of ls ‐dependNode where internal
nodes are skipped. To support compatibility with the previous behavior, we added a new flag 'internal'
which will cause the command to include all the nodes that it previously did.

Animation
367419 ‐ Preserve compatibility with Maya2011 MayaHIK setups
We made some changes that will change the compatibility with the previous files. These should be
addressed at load time
•
•
•

hikFKJoint and hikIKEffector are now used in place of joints and hikEffectors. While the old
setups would evaluate properly, some new code may fail.
Inputs PinT and PinR were replaced with output pinT and pinR.
Percentages values on property2State node are now ranging from 0 to 1 instead of 0 to 100.

378677 ‐ Animation curve different between Maya 2011 and Maya 2012
Animation curves with tangents set to quaternion cubic and quaternion tangent‐dependent have been
improved to provide smoother interpolation. This means that files from previous versions with these
tangent types will produce different results.
381276 ‐ Setting jointOrient attributes individually badly recomputes vector
Problem: Setting joint orient values individually on x, y or z in the attribute editor or via a command may
result in a new joint orient triple. This is because the value is stored internally as a quaternion.
Workaround: Set all three joint orient values at once. For example:
setAttr "joint1.jo" ‐type "double3" 90 0 0;

HIK
367419 ‐ Preserve compatibility with Maya 2011 MayaHIK setups
HIK retargeting rigs from Maya 2011 will play back, but do not work with the new HIK UI in Maya 2012.

Licensing
Sentinel 1.2 breaks a Sentinel 1.1 install on Macintosh
This will affect any product that has integrated Sentinel 1.1 for the Mac that is installed on a machine
where Sentinel 1.2 has already been installed. So far Maya 2011 is the only product we have identified
as having integrated Sentinel 1.1 for the Mac. Basically what is happening is that LMU.app and LTU.app
are not installed on the machine for Sentinel 1.1. This will affect both network and standalone license
types.
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Workaround: The supported fix would be for users to copy the LMU.app and LTU.app packages
manually onto the machine.
380146 ‐ DMM cinematic plug‐in fails to load on Linux
Maya is not compatible with selinux enforcing settings.
378003 ‐ Core dump by running setup on Fedora 14
Fedora 14 requires one to use a fully root account to run GUI programs. Do the following:
su –
Then run the installer.
This is a "new" security feature of Fedora 14.
http://fedoraforum.org/forum/showthread.php?p=1423295

Rendering/mental ray
375080 ‐ Render passes may exhibit poor shading quality with Adaptive Sampling
Workaround: Select Fixed Sampling instead of Adaptive Sampling in the Render Settings: Quality tab.
380813 ‐ mental ray shadow map overrides does not disable 'Use Ray traced Shadows' in Light
Attribute Editor
Previously, enabling 'Use mental ray shadow map overrides' in a Light Attribute Editor disabled 'Use Ray
Trace Shadows'. This is not the case in Maya 2012, and 'Use Ray Trace Shadows' must be disabled
manually.
380847 ‐ Maya may stop unexpectedly if mental ray is used to render scenes with extra shape nodes
If your scene contains extra shape nodes, for example, objects that are not meshes, and render with
mental ray for Maya, this may cause Maya to stop unexpectedly.

Maya File I/O
380799 ‐ Saving files to paths that include '.' causes files to be saved without an extension
When saving a file, if your path includes a '.', your file may be saved without an extension. To
workaround this problem, enter .ma or .mb after your file name before saving.
352137 ‐ File command can't always find files in workspace "scene" location
Previously, using the workspace command to set your "scene" file rule only worked for your mayaAscii
and mayaBinary files in the current session of Maya. If you re‐open Maya, you must have your
"mayaAscii" and "mayaBinary" workspace file rules set to this directory also; otherwise, an error
appears.
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In Maya 2012, your "scene", mayaAscii and mayaBinary file rules are all considered when a scene file is
located. Maya first looks in the location defined by the "scene" file rule, then mayaAscii, then
mayaBinary. Therefore, the default location for all scene files (.ma, .mb) is the location defined by the
"scene" file rule, regardless of file type.
If you have defined different locations for your mayaAscii and mayaBinary files, you must explicitly set
the file location to use these, as they do not appear at the default location.

mental ray Satellite and Standalone
382129 ‐ xinetd needs to be installed on the Linux platform to allow for network rendering with
mental ray Standalone and mental ray Satellite
To install, as a super user, execute the following command:
yum install xinetd
Then reboot before installing mental ray Standalone or mental ray Satellite.
382413 ‐ mental ray Satellite license update
Maya 2012 now includes four mental ray Satellite network rendering licenses, which allows you to freely
use up to four slave machines (with up to four processors each and an unlimited number of cores) for
mental ray network rendering.
Note: The Maya 2012 Help, mental ray Satellite Readme, and Maya 2012 Installation Guide incorrectly
list the number of satellite licenses as 8. The correct number of satellite licenses available in Maya 2012
is 4.

Nucleus
361522 ‐ problem with too many wrinkles with previous versions
If you load an nCloth scene file from a pre‐2011 version of Maya, set bendAngleDropoff to zero to
preserve the existing behavior of the cloth.
BendAngleDropoff previously had little effect on simulations; however it now has a strong effect on
bend resistance. Higher values now result in less bend resistance where the cloth is flatter.

Miscellaneous
Link to video in Maya Help What's New page does not accept UNC‐style paths
The Camtasia video link on the 'What's New in Autodesk Maya' page of the Maya help does not show
the 'What’s New movies' if you access the help from a UNC‐style path (for example, \\remote‐drive\). In
order to play the movies from this link, you must either install the Maya 2012 Help to a local hard drive
(for example, C:\) or map a drive to the network location where the help is installed. These movies play
properly if you access the help from the Autodesk web site.
19

311729 ‐ Comments link generates corrupted page in Japanese Safari (Mac OS X)
If you click the “Please send us your comments about this page” link at the bottom of a topic in the
Maya Help in Japanese Safari, the help system returns a corrupt page.
Workaround: Use another browser (such as Mozilla Firefox) to send comments.
369409 ‐ Possible connectControl slowdown
When using a large number of controls, and issuing commands that take control names (for example,
connectControl), you should follow these guidelines to increase efficiency:
1) Set the parent to the relevant layout or window using setParent before using a large number of
commands for the same layout/windows.
2) Use the short name for each control.
379816 ‐ OGS: dynamics scenes must play back forwards first when using Vertex Animation Cache
When using the Vertex Animation Cache attribute with a simulation, you must first play the simulation
forward once in order for the Vertex Animation Cache to build its cache correctly. After doing this, you
can scrub the timeline as you like. Note that rewinding the simulation to Frame 1 does not reset the
cache.
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